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Abstract
Mucins of the corneal and conjunctival epithelia are necessary for the protection of the ocular
surface against desiccation, pathogen access, and injury. Detection and quantification of mucins is
important for the understanding of ocular surface diseases that cause impaired vision and, in
advanced stages, blindness. Advances in the field of molecular biology have made possible to
study membrane mucins and their associated O-glycans in established cell culture models of
human ocular surface epithelia. This chapter discusses procedures to detect and quantify mucin
RNA and protein in biological samples, as well as methods to experimentally manipulate the
epithelia in culture by shRNA, to understand the function of specific mucins. Example protocols
are provided to evaluate the role of ocular surface mucins in mucosal barrier function and bacteria-
host interactions.
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1. Introduction
All wet-surfaced epithelia of the body, including those on the ocular surface, express both
secreted and membrane-tethered mucins. Of the wet-surfaced epithelia, the corneal and
conjunctival epithelia are the most exposed to the outside world and, therefore, especially
subject to desiccation, pathogen access, and injury. Thus, the secreted mucins and the
membrane mucins are especially necessary for protection of the corneal surface, the major
refractive surface of the eye, and indeed for vision itself (1).

At the ocular surface, goblet cells intercalated within the stratified conjunctival epithelia
express and secrete MUC5AC, which is then moved over the surface of the eye by lid
blinking. The apical cells of the stratified epithelium of both cornea and conjunctiva express
the membrane-associated mucins MUC1, 4 and 16, albeit central corneal epithelium lacks
MUC4 and is especially rich in MUC16 (2, 3). The membrane mucins are major
components of the surface glycocalyx and are especially prominent on surface membrane
folds termed microplicae (4). Surface diseases such as dry eye syndrome and other drying
cicatrizing surface diseases caused by Sjögren’s syndrome, ocular cicatricial pemphigoid,
and Steven’s Johnson Syndrome cause impaired vision and can, in advanced stages, cause
blindness. In these diseases, alterations in both secreted (loss of goblet cells) and membrane-
tethered mucins have been documented (5).

Since the mucin-expressing cells of the ocular surface are exposed to the external
environment, they and the fluids covering their surfaces are readily accessible for analysis of
mucin content and mucin gene expression. Thus, it has been feasible to sample human tear
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fluid as well as conjunctival epithelium in normal subjects and patients with different ocular
pathologies to compare mucin protein and O-glycan content, as well as mucin and
glycosyltransferase mRNA expression. Although human ocular surface tissue is accessible,
obviously it is not possible to experimentally manipulate the epithelia to understand function
of specific mucins and their regulation. Additionally, major differences in mucin gene
expression profiles are apparent between humans and experimental animals (e.g., mice do
not express the MUC16 homologue on their ocular surface, and they express two secreted
mucins, Muc5ac and Muc5b). Thus it has been useful to establish in vitro human epithelial
cell culture models of ocular surface epithelia, particularly for study of the membrane
mucins and their associated O-glycans (4, 6–12).

This chapter details methods employed for assay of human ocular surface epithelial mucins
in health and disease, as well as cell culture models that can be used to study membrane
mucin function and regulation relevant to corneal and conjunctival epithelia.

2. Materials
2.1. Collection of Human Samples (see Note 1)

1. Sterile transfer pipet (1 mL) with extended fine tip, individually wrapped.

2. Sterile saline (0.9% NaCl).

3. Artificial tears (e.g., Tears Naturale®Refresh Tears®).

4. Micro BCA Protein Assay Kit (Pierce, Rockford, IL).

5. Topical anesthetic (0.5% proparacaine HCl, Alcaine®).

6. 100% pure nitrocellulose membranes (Protran BA83, Whatman; Sanford, ME).

7. Topical ophthalmic antibiotic formulation (e.g., 0.3% tobramycin, Tobrex®; 0.5%
moxifloxacin HCI, Vigamox®).

8. TRIzol reagent (Gibco; Grand Island, NY).

9. RNeasy Mini Kit (Qiagen Inc., Valencia, CA).

2.2. Cell Culture
1. Corneal and conjunctival epithelial cell lines (e.g., HCLE, HCjE, hTCEpi) (9, 13)

2. Neutralization Medium: Add 55 mL newborn calf serum (final conc. 10%) and 5.5
mL 100X Penicillin-Streptomycin (pen/strep) (see Note 2) to 500 mL DMEM/F12
(50/50 mix containing L-glutamine and 15 mM HEPES; Cellgro Mediatech,
Washington, DC).

3. Keratinocyte serum-free medium (K-sfm). Add 1.25 mL of 10–14 mg/mL bovine
pituitary extract (corresponding to half the vial supplied with medium; final conc.
25–35 µg/mL), 3 µl of 30–40 µg/mL EGF (final conc. 0.2 ng/mL), 0.5 mL 0.3 M
CaCl2.H2O (final conc. 0.4 mM; medium comes with 0.09 mM CaCl2) (see Note 3)
and 5.1 mL 100X pen/strep to 500 mL of Gibco Keratinocyte SFM (Gibco-
Invitrogen Corp., Rockville, MD). Medium remains good for at least one month at

1Collection of human tear fluid and conjunctival impression cytology specimens for research purposes must be performed by an
ophthalmologist and requires compliance with good clinical practice, institutional review board regulations, informed consent
regulations, and the tenets of the Declaration of Helsinki.
2Use a 100X solution containing 10,000 U/mL penicillin G sodium and 10,000 µg/mL streptomycin sulfate in 0.85% saline (available
from Gibco-Invitrogen Corp.).
3Dissolve 0.441 g CaCl2 in 10 mL Milli-Q H2O and filter-sterilize with a 0.22 µm filter.
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4°C. All media deteriorate from exposure to light so protect from light as much as
possible.

4. Stratification medium: Add 55 mL newborn calf serum (final conc. 10%), 0.55 mL
10 µg/mL EGF (see Note 4) (final conc. 10 ng/mL), and 5.5 mL 100X pen/strep to
500 mL DMEM/F12.

5. 2X Freezing medium: Add high purity DMSO to chilled DMEM/F12 medium
supplemented with 20% calf-serum so that the final DMSO concentration is 20%
(v/v). Mix well and let stand for at least 2 h at 4°C. Filter-sterilize with a 0.2 µm
filter. Aliquot to plastic tubes. Place in a –80°C freezer to freeze solid, after which
tubes can be stored at −20°C, if desired.

2.3. Stable Gene Knockdown by Short Hairpin RNA
1. DNA oligonucleotides for MUC16 hairpin RNA expression (4) (see Note 5).

shRNA-MUC16-1:

Sense 5'-
AGCCACCTCATCTATTACCTTCAAGAGAGGTAATAGATGAGGTGGCT-3'

shRNA-MUC16-2:

Sense 5'-
CTGCATGTACTCCCATCTCTTCAAGAGAGAGATGGGAGTAGATGCAG-3'

shRNA-MUC16-3:

Sense 5'-
TAACCATCACCACCCAAACTTCAAGAGAGTTTGGGTGGTGATGGTTA-3'

2. Negative control shRNA with the same nucleotide composition as the MUC16
shRNA but lacking significant sequence homology to the human genome.

3. Vector system for expression of RNAi: pSUPER.retro.puro (linear) (Oligoengine,
Seattle, WA).

4. Annealing buffer: 100 mM NaCl, 50 mM HEPES, pH 7.4.

5. Chemically competent Escherichia coli strain: One Shot® MAX Efficiency®

DH5α™-T1R cells (Invitrogen Corp., Carlsbad, CA).

6. SOC medium: 2% Tryptone, 0.5% Yeast Extract, 10 mM NaCl, 2.5 mM KCl, 10
mM MgCl210 mM MgSO420 mM glucose. Stir to dissolve, autoclave, and cool to
room temperature. Pass the complete medium through a 0.2 µm filter. Store at 4°C.

7. LB-Amp: Dissolve 10 g bacto-tryptone, 5 g bacto-yeast extract, and 10 g NaCl in 1
L dH2O. Adjust to pH 7.0 with 1 N NaOH, and autoclave at 121°C for 15–20 min.
Allow solution to cool to room temperature. Add 500 µl of 100 mg/mL ampicillin
(final conc. 50 µg/mL). Store at 4°C.

8. Qiaprep Spin Miniprep kit and Qiagen Plasmid Plus Midi kit (Qiagen).

4Prepare a 1,000X solution: Dissolve 100 µg recombinant human EGF (Invitrogen) in 10 mL of 20 mM HEPES-buffered Earle’s salts
and 0.1% bovine serum albumin. Store frozen at −20°C.
5shRNA targets and scramble can be designed using software available from specialized companies (e.g., Oligoengine Inc.; http://
www.oligoengine.com/download/). The design tool from Oligoengine displays only the forward oligo, but the second, complementary
oligo is automatically designed and ordered. Three distinct regions of the gene should be chosen to find the most effective RNA target.
Custom complementary oligonucleotides are synthesized containing a unique 19-nucleotide sequence derived from the gene transcript.
Blast the sequences in GenBank to exclude the possible off-target effect to human genes. The loop sequence in shRNA-MUC16 is
underscored. The flanking BglII and HindIII are added to the DNA oligonucleotides for insertion into the pSUPER.retro.puro vector.
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2.4. Preparation of Bacteria for Adhesion Assay
1. Make sure when working on the bench top that glassware and pipet tips are

autoclaved, and that aseptic techniques (e.g., sterilization by flaming on a Bunsen
burner) are used while handling rims of jars and tubes, as well as insides of caps
before replacing onto jars. When autoclaving bottles, screw cap on loosely and tape
on with autoclave tape. Do not put caps, etc., down onto counter or they must be re-
flamed before use.

2. Staphylococcus aureus strains, either clinical derivatives (e.g., RN6390) or mutant
strains (e.g., ALC135) (4, 11).

3. Brain heart infusion (BHI) broth, dried powder.

4. Inoculation loops (see Note 6).

5. Fluorescein isothiocyanate (FITC).

6. HEPES buffer: 0.05 M HEPES, 0.15 M NaCl, 1 mM CaCl21 mM MgCl2pH 7.4.

7. One-well culture chamber slides.

3. Methods
3.1. Assay of Mucin Content and Expression in the Human Ocular Surface

3.1.1. Analysis of mucin content in tear fluid
1. Using a sterile transfer pipet, instill 60 µL of pre-measured sterile saline onto the

inferior fornix of an unanaesthetized eye.

2. Ask the subject to look left, then right, up and down, four times without blinking, to
mix the tear fluid content.

3. Collect the tear wash from the inferior fornix using the previous transfer pipet.
Repeat this process with the contralateral eye using a new transfer pipet. Wash out
the ocular surface with 1 or 2 drops of artificial tears after collection.

4. Remove cellular debris from the tear samples by centrifugation at 18,000 × g, in a
microfuge, for 30 min at 4°C. Collect and measure volume of supernatant using a
micropipet (see Note 7).

5. Determine protein concentration of the samples using a 2 µL-aliquot of collected
tears using the Micro BCA Protein Assay Kit.

6. Determine mucin content in tears by western blot (14) or ELISA (15). Mucin
carbohydrate content can be analyzed by fluorometric high-performance liquid
chromatography (16), lectin blot (16) or electrospray mass spectrometry (17).

3.1.2. Impression cytology for assay of mucin gene expression
1. Apply a drop of topical anesthetic to the eye and wait for 1 min.

6Sterilize the inoculation loop starting at the circular end of the loop, waiting until the wire glows, and then slowly bringing it up
through the flame, a little past the actual wire onto the handle. Hold the loop for a few sec to let it cool and test on an area of the agar
dish without colonies to see if it melts/bubbles.
7Only minor amounts of protein (insufficient for analysis) are extractable from the pellets obtained after centrifugation.
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2. Place a sterile disc of nitrocellulose membrane, 10 mm in diameter, on the temporal
bulbar conjunctiva using sterile forceps (see Note 8). Gently fold the edge of the
disc for easy handling during application and removal.

3. Apply gentle pressure to the disc with the forceps for 15–30 sec.

4. Carefully remove the disc from the eye and transfer into an Eppendorf tube
containing 1 mL TRIzol reagent.

5. Repeat the procedure with the contralateral eye using a new set of forceps and
nitrocellulose membrane. Combine the two nitrocellulose discs from each subject,
placing the empty side of the discs facing each other in the Eppendorf tube.

6. Apply one drop of topical ophthalmic antibiotic formulation onto the ocular
surface.

7. Promptly freeze the samples at −80°C until the time of extraction.

8. After thawing, vortex samples gently for 1 min. Zip spin and transfer the TRIzol
solution to a new Eppendorf tube, discarding the nitrocellulose membranes.

9. Extract total RNA with TRIzol reagent as recommended by the manufacturer (see
Note 9) and analyze mucin transcripts by real-time PCR (15). RNA samples can be
further purified using RNeasy columns and analyzed using gene expression
microarrays (18).

3.2. Induction of Cell Differentiation and Mucin Biosynthesis in Culture
1. Thaw cryovial containing corneal or conjunctival cells quickly at 37°C in a water

bath (see Note 10).

2. Transfer cells to a 15 mL centrifuge tube. Add 7 mL of neutralization medium
dropwise. Pipet up and down to mix.

3. Spin cells down at 1,500 × g for 4 min. Resuspend cells in K-sfm medium and plate
at 104 to 105 cells in 15 mL per 75 cm2 flask.

4. Set flasks in incubator (37°C, 5% CO2) where they will not be disturbed for 24 h.
Change medium next day.

5. Feed cells every two days with K-sfm until they reach 100% confluence (see Note
11).

6. Thereafter, switch cell cultures to stratification medium for 7 days (change media
on days 0, 2, 4, 5, and 6) to induce stratification, cell differentiation, and mucin
biosynthesis.

3.3. Stable Knockdown of Membrane-associated Mucin
1. Dissolve oligonucleotides in sterile, nuclease-free H2O to a concentration of 3

mg/mL.

8Prepare the nitrocellulose discs by making a circular incision on the nitrocellulose sheet with a sterile 10 mm corneal trephine.
Introduce each individual disc into a self-sealing sterilization pouch and autoclave.
9The amount of total RNA obtained by nitrocellulose membrane stripping of human conjunctiva usually varies from approximately 1
to 10 µg.
10Drop vial in container of water and shake back and forth. Watch until cells thaw. Rinse outside of vial with 70% ethanol to sterilize.
11Subculture from this medium before cells reach 2/3 confluence. To cryopreserve cells, add an equal volume of room temperature
2X freezing medium to cells already suspended to an appropriate density in K-sfm medium. Typical freezing density is 5 × 105-1 ×
106 cells per cryovial.
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2. Assemble the annealing reaction by mixing 1 µL of each oligonucleotide (sense
+ antisense) with 48 µL annealing buffer.

3. Incubate the mixture at 90°C for 4 min, and then at 70°C for 10 min. Cool the
annealed oligonucleotides to 37°C within 30 min, then at room temperature. The
annealed oligonucleotide inserts can be used immediately in a ligation reaction,
or cooled further to 4°C. For longer storage, keep at −20°C until needed.

4. Assemble the cloning reaction by adding 2 µl of the annealed oligos to 1 µL of
T4 DNA ligase buffer. Add 1 µL pSUPER.retro.puro vector (linear), 5 µL
nuclease-free H2O, and 1 µL T4 DNA ligase.

6. Incubate overnight at room temperature. A negative control cloning reaction
should be performed with the linearized vector alone and no insert (see Note
12).

7. Briefly centrifuge the vials containing the ligation reactions and place on ice.

8. Thaw, on ice, one 50 µL vial of One Shot® cells for each ligation.

9. Pipet 2 µL of each ligation reaction directly into the vial of competent cells and
mix by tapping gently. Do not mix by pipetting up and down. The remaining
ligation mixtures can be stored at −20°C.

10. Incubate the vials on ice for 30 min.

11. Heat shock cells for exactly 30 sec in the 42°C water bath. Do not mix or shake.

12. Remove vials from the 42°C bath and place them on ice for 15–30 min.

13. Add 250 µL of pre-warmed SOC medium to each vial; sterile technique must be
practiced to avoid contamination.

14. Shake the vials at 37°C for exactly 1 h at 225 rpm, in a shaking incubator.

15. Spread two volumes of 20 µL and 200 µL from each transformation vial on
separate, labeled LB-amp agar plates (pre-poured plates are commercially
available). The vector contains an ampicillin resistance ORF at 4558–5415.

16. Invert the plates and incubate at 37°C overnight.

17. Identify positive clones containing the shRNA insert by picking and growing
colonies overnight in 3 mL of LB-amp broth at 37°C at 275 rpm in a shaking
incubator (see Note 13). Isolate DNA from colonies using Qiagen’s Plasmid
Miniprep kit. Check for the presence of positive clones in a 1.5% agarose gel by
digesting with EcoRI and HindIII. Positive clones (vector with insert) should be
281 bp, whereas negative clones with no insert should be approximately 227 bp
(see Note 14). Make glycerol stocks of positive colonies and maintain at −80°C.

18. Grow large-scale cultures of transformed cells from glycerol stocks of positive
colonies to isolate large quantities of pSUPER.retro.puro to be used for
transfection into the packaging cell line. Use a Qiagen Plasmid Midi kit to
obtain enough plasmid, and store DNA at −20°C.

12After cloning and prior to transformation, plasmids should be treated with BglII to reduce the level of background in the
transformation. Add 1.0 µl of BglII to the plasmid and incubate for 30 min at 37°C. As the BglII site is destroyed upon successful
cloning of the oligo pair, those vectors cut by the enzyme will not contain the insert fragment.
13Choose at least 10 colonies from each plate for screening.
14The presence of the correct insert within the recombinant pSUPER.retro.puro vector can also be confirmed by sequencing prior to
transfection in mammalian cells.
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19. The pSUPER.retro.puro plasmid is transfected into a packaging cell line to
produce retroviral supernatants for a higher rate of stable cell integration.
Polyfect (Qiagen) has been successfully used with 293-10A1 packaging cells
(ATCC; Manassas, VA) to produce retroviral supernatants containing shRNA-
MUC16 (4). A standard laboratory protocol for transfection of 293 cells with the
pSUPER.retro.puro plasmid is available in the PolyFect Transfection Reagent
Handbook (http://www.qiagen.com/literature/).

20. Forty-eight h post-transfection, filter sterilize (0.45 µm syringe filters are
convenient) the virus-containing supernatant to remove any cells in suspension.
The virus can now be used directly or stored at −80°C until needed.

21. Plate ocular surface epithelial cells in 24-well plates at 2×104 cells per well and
grow to 40% confluence in K-sfm medium. Incubate with virus-containing
supernatant and 4 µg/mL polybrene for at least 6 h. This procedure can be
repeated to enhance infection, as long as cells are allowed to recover for 24 h
between infections with fresh K-sfm medium.

22. Infected clones are selected with puromycin (e.g., 2.5 µg/mL for HCLE cells
(see Note 15)) and further expanded to confluence to obtain stably transfected
cells. Untransfected cells should die within 5–10 days. When the selection is
complete, cells can be grown without antibiotics.

23. Allow stably transfected cells to reach confluence and add stratification medium
to induce mucin expression.

24. Seven days later, cells will be ready for functional analysis or extraction of RNA
and protein. Quantitative RT-PCR and western blotting can be used to quantify
the level of suppression of MUC16 expression.

3.4. Analysis of Mucosal Barrier Function in Vitro
1. Serum-starve stratified ocular surface epithelial cells in one-well culture chamber

slides for 2 h with K-sfm. Rinse three times with Ca+2/Mg+2-free PBS, pH 7.4.

2. Add 1 mL of 0.1% rose bengal dye in PBS to cells.

3. Incubate for 5 min at room temperature.

4. Aspirate rose bengal solution from cell culture.

5. Rinse cells once with PBS using a transfer pipet to remove excess rose bengal. Add
2 drops of PBS to keep cells hydrated.

6. Photograph cell layers (10 images per well) at 10X using an inverted microscope.
Ocular surface epithelial cells grown in stratification media will contain areas of
stratified cells that exclude the rose bengal dye (Figure 1).

7. Analyze images using ImageJ software (http://rsb.info.nih.gov/) as follows: (see
Note 16).

a. File>Open

b. Plugins>Colour Deconvolution>Select H&E vector from pull-down menu

c. Select color 2 (pink)

15Since optimal concentrations vary for individual cell types, an antibiotic kill curve should be established for each cell line.
16Analysis of multiple images is facilitated by the use of macro recording to automate the series of ImageJ commands.
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d. Image>Adjust>Threshold (see Note 17).

e. Image>Type>8-bit

f. Edit>Invert (see Note 18).

g. Analyze>Measure

h. Determine Integrated Density

3.5. Bacterial Adhesion Assay
1. Inoculate 5 mL BHI broth (see Note 19) with 20–200 µL of a glycerol stock of

S. aureus in a sterile 15 mL tube.

2. Place the cap onto the bacterial suspension tube (if using a screw-cap tube, only
screw it on loosely so air can enter the tube) and incubate statically overnight at
37°C.

3. At this point, and if unknown, determine the growth curve for each bacterial
strain by serial dilution and plate counting as follows:

a. Make a 1:100 dilution of the overnight suspension in BHI broth (step
3.5.2) to a total volume of 5 mL and place in an orbital shaker at 37°C.

b. Incubate for a predetermined period of time that will allow reaching the
stationary phase, usually 8 h, taking aliquots (325 µL) approximately
every 30–60 min, starting at time point 0. Place aliquots in a 96-well
plate or cuvettes and determine the OD595.

c. To calculate colony forming units (cfu), take 20 µl of culture at each
time point, and dilute in 180 µL of sterile PBS. Make approximately 4–
5 dilutions of the bacterial suspension that is being counted (e.g.,
10−310−410−510−6 dilutions for low OD values) and spot 5 µL of each
dilution across the top of a square agar dish. Prop dish up vertically so
drops will run down the dish (making a track) and dry. Then place plate
upside down into the incubator to let grow overnight at 37°C for counts
the next day (count dilution lane with most distinct colonies, usually
between 20 and 30) to determine cfu/mL (cfu/mL = [no. of colonies ×
dilution factor] / volume inoculated). Colonies can sometimes overlap;
look at regularity of bacterial colonies to determine whether they are
actually two or more colonies growing together.

3. Vortex the overnight bacterial suspension to break up the clumps. Dilute 1:200
into 30 mL of pre-warmed BHI using a 125 mL sterile Erlenmeyer flask (e.g.,
150 µL culture in 30 mL broth). Put flask into an orbital shaker at 200 rpm at
37°C and grow bacteria in 5% CO2 to the desired exponential growth phase
using the OD595 reading (use a predetermined growth curve for each bacterial
strain).

4. Centrifuge at 5,000 × g for 5 min at 4°C and wash the bacterial pellet twice with
10 mL PBS, pH 7.4.

5. Prepare the FITC-labeled bacteria:

17The threshold is selected after randomly opening five images and closely reproducing the staining observed in the original images.
18This allows measurement of dye uptake. To measure dye exclusion, omit this step.
19To make BHI broth, dissolve 37 g of powder in 1 L purified water; mix with a magnetic stir bar; remove stir bar and autoclave at
121°C for 15 min in bottle before use. Aliquot 5 mL of BHI broth into sterile 15 mL tubes. Always inoculate a dummy tube with no
cells to verify that the medium and tubes are sterile. Use this tube as blank while taking OD595 readings.
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a. Incubate 5 mL (5 × 109 cfu/mL) S. aureus in PBS with 1.25 mL of a
stock solution of 500 µg/mL FITC (final conc. 100 µg/mL) for 30 min
on ice (see Note 20). Mix the suspension by vortexing every 5 min to
avoid cell clumping/aggregation.

b. Collect labeled bacteria by centrifugation at 5,000 × g for 5 min at
10°C and wash six times with 10 mL PBS, vortexing each time to
ensure thorough washing.

c. Resuspend the bacterial pellet in DMEM/F12 to a final concentration of
1 × 108 cfu/mL and maintain on ice, protected from light until needed.

7. Perform bacterial adhesion experiments in ocular surface epithelial cells grown
on one-well culture chamber slides. Twenty h prior to assay, switch into an
antibiotic-free stratification medium.

8. Wash slides three times with sterile HEPES or PBS buffer.

9. Incubate each slide with 2 mL FITC-labeled bacteria (1 × 108 cfu/mL) for 1 h at
37°C. Maintain slides in the dark or covered with aluminum foil.

10. Carefully wash four times with PBS to remove non-adherent bacteria, and fix in
4% paraformaldehyde for 30 min at room temperature.

11. Wash four times with PBS and apply Vectashield mounting medium (Vector
Laboratories; Burlingame, CA). Add coverslips to the slides and image them
under a fluorescence microscope.

12. Analyze images using ImageJ software (NIH; Bethesda, MD).
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Fig. 1.
Rose bengal is an organic anionic dye used to assess damage to the ocular surface
epithelium in ocular surface disease. Application of rose bengal onto the ocular surface
results in patches of superficial punctate staining in patients with epithelial damage (B), but
not in normal subjects (A). In culture, human corneal epithelial cells grown in stratification
media contain areas of stratified cells that exclude the rose bengal dye (C). The amount of
rose bengal uptake can be determined using ImageJ software (D) as described in step 3.4.7.
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